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Atmospheric Neutrinos
‣ Secondary cosmic ray showers create 
neutrinos by e.g. 
    π± → μ± + νμ(ν̅μ) 
              μ± → e± + νe(ν̅e) + ν̅μ(νμ) 
    K → same (or pions) 

‣ These can be termed “conventional” 
neutrinos. 

‣ Also, higher energy charm components 
(“prompt” neutrinos, due to the short 
lifetime of charmed hadrons).
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Atmospheric Neutrino Flux Models
‣ Flux MCs propagate primaries and secondaries according to 
geomagnetic and atmospheric models, and track neutrinos arriving 
at a given location on Earth. Several models are available:
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Motivations for Direct Measurements
‣ Accurate flux prediction necessary for any study of the atmospheric 
neutrino as a signal (e.g. oscillation studies) or as a background (e.g. 
proton decay, dark matter, astrophysical neutrinos).
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Super-Kamiokande
‣ PID and energy classification by Cherenkov light pattern. 
‣ ~20 years of operation.
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Event Classification
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‣ Events divided by topology, 
defining sub-samples with 
different energy resolution 
and neutrino flavour purity. 
‣ Fully Contained 
(FC, νe or νμ by PID) 

‣ Partially Contained  
(PC, νμ only) 

‣ Upwards-Going Muons  
(UPMU, νμ only)
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Event Classification
‣ Events divided by topology, 
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Event Classification
‣ Events divided by topology, 
defining sub-samples with 
different energy resolution 
and neutrino flavour purity. 
‣ Fully Contained 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Event Classification
‣ Events divided by topology, 
defining sub-samples with 
different energy resolution 
and neutrino flavour purity. 
‣ Fully Contained 
(FC, νe or νμ by PID) 

‣ Partially Contained  
(PC, νμ only) 
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Energy Spectra



Energy Spectrum Unfolding
‣ Aim to reconstruct the true νe
+ν̅e and νμ+ν̅μ fluxes at the 
detector position (model-
independent measurement). 

‣ Detector response matrix is first 
estimated by MC, then an iterative 
Bayesian method is applied. 
Reliable result with accurately 
estimated unfolding related 
uncertainties.
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Measured Flux
‣ Plotted against the HKKM11 flux 
model (dashed line shows 
unoscillated prediction). 

‣ Error bars include the effects of all 
statistical and systematic 
uncertainties (cross-sections, 
detector reconstruction, oscillation, 
and regularization) as estimated by 
toy MC.
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Flux Model Comparisons
‣ Compare against current 
flux models by χ2 test 
(accounting for error 
covariance matrix). 

‣ No models are strongly 
inconsistent (for the νμ+νe 
test, p=32% for Fluka and 
13% for Bartol).
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Flux Model Comparisons

‣ Also check the normalization 
and spectral index of the flux 
models. 

‣ Generally consistent, some 
disagreement with the spectral 
index of Fluka νμ.
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Comparison to Other Measurements
‣ Our data provide improved 
precision, extending up to 100 
GeV for νe and 10 TeV for νμ, 
and the first data below 320 
MeV. 

‣ Overlap with km3 detectors 
allows our data to provide 
extended constraints. 
‣ In particular, should be helpful 
to measure more accurately 
the astrophysical neutrino flux. (E/GeV)
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Geomagnetic Effects
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Geomagnetic Effects
‣ The rigidity cutoff due to the geomagnetic field is a function of 
position and direction at the Earth’s surface. 

‣ There are well-known effects on the primary and secondary CR flux, 
such as the “east-west effect” dipole asymmetry.

‣ We test for any 
asymmetries in 
the neutrino 
flux, primarily by 
the azimuthal 
distributions.



Azimuthal Distributions
‣ Showing various energy and zenith ranges. Testing against the 
HKKM11 model, which uses the IGRF-10 magnetic field model.

380

400

420

440

460

480

500

520 < 0.4 [GeV]rec0.1 < E

300

350

400

450

500

550

< 1.33 [GeV]rec0.4 < E

80

100

120

140

160
< 3.0 [GeV]rec1.33 < E

0 60 120 180 240 300 360

60

70

80

90

100

110 [GeV]rec3.0 < E

140

160

180

200

220

240 > 0.6�1.0 > cos 

140

160

180

200

220

240

260 > 0.2�0.6 > cos 

160

180

200

220

240

260

280

300

320

> -0.2�0.2 > cos 

160

180

200

220

240

260

280 > -0.6�-0.2 > cos 

0 60 120 180 240 300 360
160

180

200

220

240

260 > -1.0�-0.6 > cos 

[deg]⇥Azimuth [deg]⇥Azimuth 

260

280

300

320

340

360

380

400

420 < 0.4 [GeV]rec0.2 < E

350

400

450

500

550

600

650 < 1.33 [GeV]rec0.4 < E

80

100

120

140

160

180

200 < 3.0 [GeV]rec1.33 < E

0 60 120 180 240 300 360

20

30

40

50

60 [GeV]rec3.0 < E

200

220

240

260

280

300

320
> 0.6�1.0 > cos 

160

180

200

220

240

260

280

300 > 0.2�0.6 > cos 

140

160

180

200

220

240

260 > -0.2�0.2 > cos 

120

140

160

180

200

220

240 > -0.6�-0.2 > cos 

0 60 120 180 240 300 360
120

140

160

180

200

220
> -1.0�-0.6 > cos 

[deg]⇥Azimuth [deg]⇥Azimuth 

νe sample                      νμ sample



East-West Dipole Asymmetry

‣ Test for the dipole 
asymmetry in each plot, 
by the parameter 

       A = (nw + ne) / (nw - ne) 

   where ne (nw) are the  
   number of east (west) 
   going events.
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East-West Dipole Asymmetry
‣ Selecting a sub-sample of 
events by zenith angle 

        |cos(θ)| < 0.6 

    and reconstructed energy 

        400 < Erec < 1330 MeV 

    optimizes for the sample 
    with strongest predicted  
    dipole asymmetry. 
‣ Significance of a nonzero asymmetry is improved from previous 
measurements1 by 4.9 → 8.0σ (2.2 → 6.0 σ) in the νe (νμ) sample.
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1. Phys. Rev. Lett. 82, 5194 (1999)



Zenith Dependency of Dipole Asymmetry
‣ Check zenith dependency of dipole asymmetry angle by fitting the 
azimuthal distribution in each zenith bin by 

        k1*sin(φ+B) + k2 
‣ 2.2σ significance of a 
non-zero dependency. 

‣ First measurement to  
explore beyond simple 
east-west asymmetry.
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Solar Modulation



Solar Cycle and Neutron Monitors
‣ The solar cycle is an 11-year modulation of the solar structure, and 
emitted plasma flux, well known to affect CRs approaching the Earth. 

‣ Test to see if the neutrino flux is similarly correlated. 
‣ We compare the neutrino flux to 
the neutron flux at ground level 
on the Earth. 
‣ Constantly and accurately 
measured, with no delay of  
plasma flux propagation, and 
expected to be well correlated 
to the primary CR flux. Year
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Effects on the Super-K Data
‣ Test for the correlation as predicted by the HKKM group. 

‣ Use SK samples with 100 < Erec < 1330 MeV.
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Results - Long Term Search
‣ Bin events by NM count, 
and fit the four samples 
simultaneously across ~20 
years of SK data. 

‣ Fitted by continuous parameter 
α, where α=0 is no correlation 
and α=1 is the predicted 
correlation. 

‣ Best fit α = 0.62 ± 0.58 
‣ Significance of a nonzero 
correlation = 1.1σ 
(expected sensitivity 1.8σ) 
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Results - Forbrush Decreases
‣ For very high solar activity (NM count < 330,000 hr-1) no prediction 
is available, but we have 7.1 days of detector uptime. 

!

!

!

!

‣ Expect 32.80 ± 0.17 events (in four samples), but only 20 observed. 
‣ P-value to observe 20 or less events p = 0.017 
‣ 98.3% (2.38σ) rejection of no-correlation hypothesis.

Start End Hours
15 Jul. 2000 17 Jul. 2000 50
11 Apr. 2001 13 Apr. 2001 38
29 Oct. 2003 01 Nov. 2003 61
02 Nov. 2003 04 Nov. 2003 67
19 Jan. 2005 19 Jan. 2005 13

Total 229



Summary



Summary
‣ The energy spectrum of the νe+ν̅e  and νμ+ν̅μ fluxes were measured at SK over 
100 MeV to 10 TeV, with the current best accuracy up to ~100 GeV. 

‣ Overlaps with the IceCube measurements (which are ≳100 GeV). 
‣ Consistent with current flux models (HKKM11, Fluka, Bartol) with some 
preference for HKKM11 as the best fit. 

‣ The azimuthal spectra were compared with the HKKM11 model using IGRF-10. 
‣ The east-west dipole asymmetry was seen at 6σ (8σ) for the νμ (νe) sample. 
‣ Indication of an azimuthal dependence of the dipole at 2.2σ. 

‣ A correlation with the solar cycle over 20 years of data was seen with only a weak 
preference (1.1σ compared to expected 1.8σ sensitivity). 

‣ Considering more extreme solar activity (7.1 separate days of data), some 
correlation was seen at 2.4σ.
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Energy Unfolding - Data
‣ Raw data, and MC with estimated purities.
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Energy Unfolding - Iterative Bayesian Method
‣ If NCCi is the true energy spectrum (bins i), and Mj is the 
reconstructed energy spectrum (bins j), then define priors 
 
 
and state Bayes’ theorem 
 
 
then make estimation based on the data  
 
 
and take the result as new priors, to proceed iteratively. 
Background events are considered as a possible cause.



Energy Unfolding - Systematic Errors
‣ Detailed systematic error analysis for neutrino cross-sections, 
reconstruction, and oscillation parameter related uncertainties.

i bins
0 2 4 6 8 10 12 14 16 18 20 22

 [%
]

Φ/
Φ

∆

0

5

10

15

20

25

30

35

eν µν

total
statistical 
cross section 
detector
oscillation and regularization



Energy Unfolding - Error Matrix
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Energy Unfolding - Bias Check
‣ Unfold toy spectra with modified normalization α and spectral index 
γ, to estimate any bias coming from the initial MC expectations.
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Energy Unfolding - Other Checks

‣ Unfolding by up / down fluxes separately 
(UPMU is upwards only). 

!

!

‣ Unfolding by each SK period (showing 
statistical errors only).
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ν / ν̅ Separated Energy Unfolding
‣ Using kinematics (no charge separation by electric field possible in 
Super-K), some separation power between ν and ν̅ ̶ though 
results have meaning only in a comparative sense (preliminary).
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Azimuthal Systematics
‣ SK detector is highly azimuthally symmetric, although some energy 
systematic may exist at the <1% level. 

‣ Other systematics (such as differences in the east and west going 
energy spectra) can contribute in second-order.
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Lepton → Neutrino Directional Correlation
‣ Dominant uncertainty in reconstructing the neutrino direction in 
CCQE events comes from the poor correlation with the emitted 
charged lepton direction (worse at lower energies).
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Azimuthal MC Truth Distributions
‣ The same events as shown 
in the reconstructed plots, 
but rebinned using the 
true lepton direction and 
momentum.
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Solar Modulation - Hypothesis Test
‣ Hypotheses for expected number 
of events based on the scaleable 
parameter α, in turn based on 
the HKKM prediction. 

!

!

‣ Black line has α = 0, blue data 
points have α = 1.
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Solar Modulation - Hypothesis Test
‣ If Ns,i are our data and H’s,i is our hypothesis (in data sample s and bin 
i) then define the log-likelihood as  
 
 
 
where ε is a penalty term from systematic error pulls, where the 
hypothesis has been modified appropriately. Then, our statistic is 
 
 
 
where M denotes minimization over systematic errors and α (except 
in the demoninator where α is fixed).



Solar Modulation - Hypothesis Test
‣ Final significance parameter.
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Solar Modulation - NM Correlations
‣ Conversion factor between the four NMs we use, and the Climax NM
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Solar Modulation - Toy MCs
‣ Toy MC example datset. 
‣ 1000 toy MCs used to 
confirm the test statistic 
is distributed as 
expected, unbiased, etc. 

‣ Expected sensitivity to 
the effect (assuming 
α=1) is 1.75σ.
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Solar Modulation - Results By Sample
‣ Fit for α independently, first by SK period, then by sample type. 
‣ Somewhat interestingly, νe prefers no correlation while νμ prefers 
the expected correlation, although statistical power is low.
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